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Credit Card Handling 
Overview  
FACTS offers two methods for processing credit card transactions: manual 
and automatic. FACTS by itself allows you to process these transactions 
manually via voice authorization. Automatic credit card processing is 
possible by integrating the FACTS system with ICVERIFY or Payflow Pro 
software and magnetic stripe devices, which are purchased separately from 
ICVERIFY, Inc or Verisign. (See www.icverify.com or for www.verisign.com 
more information.)   

With either method, FACTS users can perform sales, credits and voids. 

Credit Card Processing with ICVERIFY or Payflow Pro 

ICVERIFY and Payflow Pro are a third-party credit card processing software 
packages that can be integrated with FACTS to provide automatic credit card 
processing capabilities.  

The company also offers several types of magnetic card stripe readers that plug 
into to terminals or PCs. No device drivers or link files are required. Credit card 
processing companies often offer higher discounts to companies using card swipe 
devices. 

Credit Card Processing with Payflow Pro  

When processing for Payflow Pro, FACTS uses the PayPal Processing (SOC611) program gathers all 
information (according to the selections chosen in Credit Card Control F/M (SOF957)). 
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The system displays the amount, but it cannot be changed on this screen. You can enter the Credit 
Card Number manually, or by a swipe by pressing the “Swipe” button, or F1. When you press the 
“Swipe Card” button, FACTS displays a message indicating that it is waiting for the card to be 
swiped. You can press F4 to cancel. The system remembers the last mode system was in when the 
credit card information was successfully gathered (swiped or manually entered), and stores this in the 
SMT record so that the next time you access the Credit Card Information screen, it is in the same 
mode as last time. The program displays the credit card number in the Credit Card Number field, and 
other track data into the appropriate fields. The system disables the Credit Card Number and 
Expiration Date fields after you swipe the credit card.  Use the Clear button to clear all fields and 
enable the Credit Card Number and Expiration Date fields again, and enter the program in the state 
set by the SMT record (either in swipe mode or manual mode). 

Credit Card Processing with ICVERIFY 
ICVERIFY is a third-party credit card processing software package that can be 
integrated with FACTS to provide automatic credit card processing capabilities. 
The company also offers several types of magnetic card stripe readers that 
interface with FACTS terminals. Since the card readers are recognized as 
keyboard devices, no device drivers or link files are needed. 
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Using PayPal Payflow Pro 
PayPal Payflow Pro Installation and 
Implementation Tips 

Communication with authorization networks and payment service providers is enabled by full FACTS 
integration with ICVERIFY or PayPal Payflow Pro. This section describes the integration with PayPal and 
how to install Payflow Pro for use with the Sales Orders module. These instructions are intended as a 
supplement to the installation instructions provided by PayPal. You should also have the Payflow Pro 
documentation available when performing the installation. Please contact PayPal for the current 
requirements and installation instructions. You can contact PayPal at 1-888-847-2747 or on the web at 
www.paypal.com. 

As you are getting started with PayPal, you can contact them for technical support for your test and/or 
merchant accounts. To contact PayPal’s Customer Support Services, call l 888-847-2747 or e-mail payflow-
support@paypal.com. 

The content is provided only as an additional guide to your installation. Because 
third-party product information is included, the content is subject to change 
without notice. 
 

Integration with Payflow Pro 

Sales Orders interfaces with Payflow Pro to provide seamless electronic payment (credit card and ACH) 
functionality. Payflow Pro is compatible with Windows XP, 2000, and 2003 and will need to be loaded on 
a central networked PC, which will communicate directly with iSeries clients allowing FACTS 
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transactions to be sent to PayPal’s Payment Gateway via a secured Internet connection integrated with 
FACTS and connects to Payflow Pro’s Payment Gateway. Once transactions are received by PayPal’s 
Payment Gateway, they may be processed on many different authorization networks, allowing you many 
choices and flexibility in establishing and maintaining merchant accounts. 

 

PayPal 
 

TakeStock 

 

Installing Payflow Pro 
When you install Payflow Pro, you will begin with a test account and then switch to a live merchant 
account. This section provides supplemental information for this installation and setup. 

Payflow Pro must be loaded on every  

• client which will be processing electronic payments and/or running invoicing or processing Payflow 
Pro transactions which may be affected by electronic payments. 

• batch and/or Progress AppServer which may be processing electronic payments web transaction, 
batch EP transactions (such as invoicing and/or batch authorizations), and/or Day-End Processing. 

All computers on which Payflow Pro will be installed must have Internet access to process transactions to 
the payment gateway. 

2-2  Copyright © 2007 Infor Global Solutions 



Electronic Payments Guide — FACTS 7.6.1 Using PayPal Payflow Pro 

Payflow Pro must be installed on a networked PC within your company’s firewall and the FACTS server 
must be able to access this PC’s IP address. This PC must have Internet access to process the transactions 
to the authorization network. 

Getting Started with a Test Account 

This section describes how to create a test account, set up PayFlow Pro, and set up Sales Orders to 
process credit card orders in a test environment. A test account uses test credit card numbers provided by 
PayPal with a test authorization network. Once you have established that your system is working in a 
test environment, you can switch to a merchant account, which uses valid credit card numbers with a live 
authorization network. Refer to Switching from a Test Account to a Live Merchant Account for information 
about transitioning to live processing. 

1. Test your connectivity. 
To test the connectivity between the PC on which Payflow Pro will be installed and the FACTS server, 
obtain the IP address of the PC and then use the ping command on the FACTS server to verify the 
connection to the PC. To do this: 
a. Right-click Start, then select Explore. 
b. In the menu tree, right-click My Computer, then select Properties. 
c. Click the Computer Name tab and record the full computer name. 
d. From the Start menu, select Run. The Run Window appears. 
e. In the Open field, key cmd and press ENTER to open an MS DOS prompt. 
f. At the prompt, key ping [full computer name] (using the full computer name recorded in step c) 

and press ENTER. The IP address of the PC will be returned. Record this IP address. 
g. To use the ping command on the FACTS server, on a FACTS server command line key ping [‘PC IP 

Address’] (using the ‘address’ recorded in step f). If you receive a message of no response from 
host, there is either a network problem or IP address conflict. You will need to resolve the issue 
before you proceed. 

2. Create a test account for Payflow Pro.  
You will use the test account to install and test Payflow Pro with Sales Orders. Once you have verified 
that your system is functional using the test account and you have applied for a merchant account, 
you can switch to a live account. Refer to Switching from a Test Account to a Live Merchant Account.  
a. Go to www.paypal.com. 
b. Select Merchant Services at the top of the page. 
c. Under the Payflow Gateway section, click the Sign Up link. 
d. Leave Payflow Pro selected and click the Go button. 
e. Review the setup requirements and click Continue. 
f. Leave Payflow Pro selected and select any Value Added Services you want. Click Continue. 
g. Create your merchant ID and provide your business information. In the Select Processor section, 

select your transaction network. Click Continue. 

Note: The user ID and password must be equal to or less than 12 characters. 
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Note: The email address you provide in this section will be the email address to which 
confirmation of the account creation is sent. 

h. Review the terms and conditions. 
i. You will receive an email with your you account information. This email contains your partner ID, 

the URLs for logging in to the PayPal Manager, and other information about managing your 
account. 

3. Download Payflow Pro. 
If you are using a UNIX-AIX machine, refer to Using Payflow Pro on a UNIX-AIX Machine for this step. 
a. Log in to your account at https://manager.paypal.com//loginPage.do. When logging in, your 

partner ID is PayPal. Use the user ID and password you specified when you created the test 
account. 

Note: The user ID and password are case sensitive. 

b. Once you have logged in, click the Downloads link at the top of the page. 
c. Click the Windows 2000, 2003 link for Payflow Pro Software Development Kit. 
d. Accept the user agreements. 
e. Download the .zip file. 
f. Extract the .zip file to the root directory. The extraction will create a folder at the root directory, 

such as C:\paypal. The remainder of the instructions will assume that C:\paypal is your 
installation directory. If you do not extract the files to that directory, adjust the instructions 
accordingly. 

4. Register the pfpro.dll 
a. Copy the pfpro.dll from the C:\paypal\payflowpro\lib to one of the following directories: 

for Windows NT: C:\winnt\system32 
for Windows 2000, XP, and 2003: C:\windows\system32 

b. Browse to C:\paypal\payflowpro\win32\com. 
c. Double-click the PFProCOMSetup.exe file in that folder. This executable will register the pfpro.dll 

and complete the client set-up. 
5. Set the PFPRO_CERT_PATH environment variable. 

The PFPRO_CERT_PATH environment variable must point to the directory that contains the 
f73e89fd.0 file. 
If you are using Windows NT: 
a. Right-click My Computer and select Properties. 
b. Click the Environment tab. 
c. On the Environment tab, create a new system variable PFPRO_CERT_PATH with the value equal 

to the following sub-directory: C:\paypal\payflowpro\win32\certs. 
d. Reboot the machine. 
If you are using Windows 2000, XP, or 2003: 
a. Right-click My Computer and select Properties. 
b. Click the Advanced tab. 

2-4  Copyright © 2007 Infor Global Solutions 



Electronic Payments Guide — FACTS 7.6.1 Using PayPal Payflow Pro 

c. On the Advanced tab, create a new system variable with the value equal to the following sub-
directory: C:\paypal\payflowpro\win32\certs. 

d. Reboot the machine. 
6. Complete the set up for Sales Orders and process credit card orders in your test environment. 

You are now ready to set up your Sales Orders options on the host. Refer to the Credit Card InterLink 
users guide for help setting those options. When you are setting up the merchant, enter the following 
in Merchant ID Maintenance (MENU EPFILE): 

Note: These entries are case-sensitive; be sure when entering user IDs and password that 
the case is correct. 

Interface = 3 
Host Address = test-payflow.verisign.com 

Note: When you switch to a live account, you will need to remove the test- from this field. 

Host Port = 443 
Partner ID = paypal 
Vendor = Payflow Pro account user ID 
User ID = Payflow Pro account user ID 
Password = Payflow Pro account password 
You can use test credit card numbers to test credit card transactions.  
• MasterCard: 5555555555554444 
• Visa: 422222222222 
• American Express: 37144935398431 

Using Payflow Pro on a UNIX-AIX Machine 

This section describes how to install Payflow Pro on a UNIX-AIX machine. To use Payflow Pro on a 
UNIX-AIX machine, you need to use the Java version of Payflow Pro, called the Payflow Pro Pure Java 
Client. The JDK 1.2 or higher needs to be installed on the UNIX-AIX machine to support the Java version. 
To download the Payflow Pro software, follow the next step. 

1. Download Payflow Pro. 
a. Log in to your test account at https://manager.paypal.com. When logging in your partner ID is 

PayPal. Use the user ID and password your specified when you created the test account. 

Note: The user ID and password are case sensitive. 

b. Once you have logged in, click the Downloads link at the top of the page. 
c. Click the Pure Java Any JDK link for Payflow Pro Software Development Kit. 
d. Accept the user agreements. 
e. Download the .zip file. 
f. Extract the .zip file to the root directory of your UNIX-AIX drive. The extraction will create a 

PayPal folder at the root directory, such as, C:/paypal. The remainder of the instructions will 
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assume that C:/paypal is your installation directory. If you do not extract the files to that directory, 
adjust the instructions accordingly. 

g. Set the class path to the Java files. The following instructions include both the C Shell and Bourne 
Shell environment commands for setting the CLASSPATH: 

 
C SHELL: 
#!/bin/csh 
if ($?CLASSPATH) then 

setenv CLASSPATH ${CLASSPATH}:Verisign.jar:. 
else 

setenv CLASSPATH Verisign.jar:. 
endif 
setenv CLASSPATH ${CLASSPATH}:jsse.jar:jcert.jar:jnet.jar 
 
BOURNE SHELL: 
#!/bin/sh 
CLASSPATH=${CLASSPATH:-}:Verisign.jar:.;export CLASSPATH 
CLASSPATH=${CLASSPATH:-}:jsse.jar:jcert.jar:jnet.jar;export  
CLASSPATH 
For JDK 1.4, omit the CLASSPATH definition of jsse.jar, jcert.jar and jnet.jar. 
Modify your java.security file to configure Java to use the JSSE. This can be found in 
$JAVAHOME/jre/lib/security/java.security. Also add the following entries to your java.security 
file: 
• security.provider.1=sun.security.provider.Sun 
• security.provider.2=com.sun.net.ssl.internal.ssl.Provider 
If you already have existing entries, use the next number available. Make sure that the Payflow Pro 
client cert (f73e89fd.0) can be found by the client. To accomplish this, the call to SetCertPath() in 
PFProJava.java may need to be changed to set the directory that contains the file f73e89fd.0.  For 
more information on this method, see the javadoc documentation in javadoc directory. 

2. Using Progress AppServer on a UNIX-AIX machine. 
a. If you are using the Progress AppServer on a UNIX-AIX machine, you will need to add the 

CLASSPATH environment variable to the AppServer setup.  

Note: Payflow Pro must be loaded on every Client, Batch Server, Web Server, and 
AppServer, which will be processing Electronic Payment transactions. All servers 
must have Internet connectivity. 
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Switching from a Test Account to a Live Merchant Account 

When you are finished testing Sales Orders in your test environment and you are ready to begin using 
electronic payments in a live environment, you complete the steps in this section to switch to a live 
merchant account. 

1. Apply for a merchant account with PayPal. 
PayPal provides an automated online application that you will use to apply for a merchant account. 
a. Log in to your PayPal account at https://manager.paypal.com. 
b. Follow the instructions for applying for a merchant account. You will need 5-10 minutes to 

complete the application. Account approvals typically take 24 hours. 
2. Set up your Credit Card Options for the merchant account. 

At minimum, you will need to change the host address to the merchant account address 
(payflow.PayPal.com). You may also need to change your user ID and password. 

3. Verify your PayPal Security Transaction Settings. 
a. Log in to your account at HTTPS://manager.paypal.com. When logging in, your partner ID is 

PayPal. Use the user ID and password you specified when you created the account. 
b. In the PayPal Manager, select the Security link at the top of the page. Then select the Transaction 

settings on the left. 
c. In the Edit Your Transactions: section, be sure the Allow Non-referenced Credits: setting is Yes.  
d Verify that the remaining settings in the Edit Your Transactions: section are correct. 
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Configuring the  
ICVerify/FACTS Integration 
FACTS offers two methods for processing credit card transactions. FACTS, by 
itself, allows you to process these transactions manually via voice 
authorization. Automatic credit card processing is possible by integrating the 
FACTS system with ICVERIFY software and magnetic stripe devices, which are 
purchased separately from ICVERIFY, Inc. (See www.icverify.com for more 
information.)   

With either method, FACTS users can perform sales, credits and voids. 

Setting up credit card handling for voice 
authorization  
1. Set up a cash type terms code in the Accounts Receivable Terms Code 

F/M. Credit cards must be cash type payments, not an A/R type. The 
General Ledger Number you choose must be a cash G/L account number. 

2. Go to the Credit Card Control F/M in Sales Order Infrequent File 
Maintenances. 
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• Select the Use Voice Authorization Only checkbox. 

• Select the User Address Verification checkbox based on your company 
needs. If you select this checkbox, the system requires that you enter the 
customer’s address and Zip code on all transactions. 

• Select the Use Last 4 Digit Security checkbox. Credit card transactions 
work with this flag set to N; however, for your customers’ benefit, it is 
recommended that you activate this flag. 

• Enter the number of columns over which you want the credit card 
receipts to print. The available range is between 30 and 80 columns (30 
gives you a 2½-inch wide receipt).  

• Enter the message you would like printed on the receipts. This entry is 
optional. 

Credit Card Processing with  
Voice Authorization 

When you enter a credit card payment, FACTS opens a pop-up window, which 
confirms that you are in voice-authorization mode and the amount of the 
purchase and whether the transaction is a sale, void sale, credit or void credit.  

In this window, enter the customer’s credit card number and the expiration 
date.   

The system then asks whether it is OK to process a sale.  

Enter Y to continue with the sale, and call your credit card processing company 
to authorize the sale. Enter the authorization code in the prompt provided. 

STATUS 

AUTH CODE ......... 
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Credit Card Processing with ICVERIFY 
ICVERIFY is a third-party credit card processing software package that can be 
integrated with FACTS to provide automatic credit card processing capabilities. 
The company also offers several types of magnetic card stripe readers that 
interface with FACTS terminals. Since the card readers are recognized as 
keyboard devices, no device drivers or link files are needed. 

Configuring FACTS to work with ICVERIFY 

1. Go to the System Management System Control F/M. Enter the number of 
ICVERIFY licenses your company purchased at the ICVerify Licenses field. 
FACTS supports up to 999 licenses. 

2. Set up a credit card terms code in the Accounts Receivable Terms Code 
F/M if you have not already done so. Credit cards must be set up as a cash 
type; so the General Ledger number you choose must be a cash G/L 
account number.  

3. Edit the Credit Card Control F/M. 

• Enter the Transaction Polling Directory. This is the path to the server 
acting as your ICVERIFY “master” station (see the ICVERIFY user 
manual for more information on its setup). The path must be 60 
characters or less. 

• Set the recognition time out value up to 999 seconds.  

• Set the response time out value.  

• Select the Use Address Verification checkbox, based on your company’s 
needs. If you select this checkbox, then anyone running a credit card 
transaction will be required to enter the customer’s address after swiping 
their card. 

• Do not select the Use Voice Authorization Only checkbox.  

• Select the Use Last 4 Digit Security checkbox, based on your company’s 
needs.  

• Select the Transmit to ICVERIFY flag checkbox.  

• Enter the number of columns over which you want the credit card 
receipts to print. The available range is between 30 to 80 (30 columns 
will give you a 2½-inch wide receipt). 

• Enter the message you would like printed on the receipts. This entry is 
optional. 

4. (Optional) To print credit card receipts, set up SOP610 in Program F/M.  Then select the printer 
usage and normal printer for each terminal (the entries for fields 2-8 are arbitrary) so credit card 
receipts will print. This allows you to have one credit card receipt printer for all terminals, or a 
different printer for some terminals, as necessary. 
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Card Reader Requirements 

Your card reader must be configurable to match the following requirements:  

• Returning both card tracks  

• Prefacing the read (or the first track) with a header of "%"  

• Terminating each track w/either a carriage return ($od$) or a line feed ($0a$)  
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Working with automatic credit card transactions 
After entering the terms code and the purchase amount, the credit card pop-up 
window appears.  

1. Enter the credit card number or swipe the card through the reader. 

2. Enter the expiration date. If you swiped the card, the system automatically 
enters this data. 

3. If you select the Use Address Verification checkbox in the Credit Card 
Control F/M, enter the customer’s street address and Zip code.  

4. The system now asks whether to proceed with the sale.  Answer Yes and 
press Enter (CR). 

A mini dialog box will appear, telling you the system is waiting for 
recognition and then a response.  

If the credit card processing company does not answer or respond within 
the time set in the Credit Card Control F/M, the system gives you either a 
recognition timeout (if the provider does not respond at all) or a response 
timeout (if the provider’s system answers but does not approve or decline 
within the response time). 

Recognition timeouts. You may wait again or cancel the transaction. 
Canceling a document after a recognition timeout creates no problems 
because the processing company is not aware of the transaction.    

Response timeouts. You have the option to wait or hold the document. If 
you choose to hold, you must call the processing company to determine 
whether the transaction has been approved or declined. 

If for some reason the swipe device isn’t working, the card processing 
company is offline or the Voice Authorization flag in the Credit Card 
Control F/M is set to Y, the person entering the credit card transaction will 
need to call the processing company and enter the provided authorization 
code in the prompt that appears. 

At the end of the transaction, FACTS checks to see if you are signed on to a cash 
drawer. If not it asks you to do so. Press F2 or  to search. 
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Using the Process Pending Transactions program  
(Communications down) 

In cases where your processing company is offline or ICVERIFY is down, you 
can still force sales and reconcile the transactions later.  

At the end of the shift or day, enter the Process Pending Transactions program 
from the Invoices menu. If transactions are pending, press Enter (CR) to begin 
processing. This program must be run before the Daily Sales Register is updated. 

If everything runs smoothly, the system tells you the “Batch Processing of 
Pending Transactions Is Complete,” and you can press Enter (CR) to return to 
the Invoices menu. 

If a transaction is declined, it must be resolved (e.g. with another method of 
payment), and the Process Pending Transactions program must be run again. 

As with single credit card transactions, recognition and response timeouts 
sometimes occur. If you get a recognition timeout, you can wait or press F3 to 
stop processing. 

If you are faced with a response timeout, you can either wait or abort the 
process. Be advised that when you abort the process, you will need to call your 
processing company and verify which transactions they received. Those they 
did not receive will have to be settled through the ICVERIFY software.  

Refer to the Sales Orders manual for more information on Credit Card 
Handling F/M and Process Pending Transactions. 
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TCP/IP Manager for 
Electronic Payments 

Before you begin 
Â Install VeriSign or PayPal Payflow Pro on a PC 

Â Disable any anti-virus software products 

Â Exit all Windows programs 

Â Disable all screen savers 

 

Installing the TCP/IP Manager 
1. Place the FACTS Installation CD in the CD drive. 

2. Wait for the InstallShield to start automatically or if autorun is not enabled 
on your computer, run FACTS75.exe from the CD. 

3. Select FACTS. 

4. From the FACTS screen, select TCP/IP Manager. 

5. Click Next at the welcome screen. 

6. Enter your customer information, and click Next. 

7. The destination directory defaults to C:\Program Files\Infor Global 
Solutions\TCPIP Manager – Electronic Payments\.  Choose Browse to 
change drives or directories.  Click Next. 

8. Review the installation settings, and click Next to begin copying files. 
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9. When the installation is complete, click Finish. 

Starting the TCP/IP Manager – Electronic Payments 
1. Double click the Launch TCP/IP Manager – Electonic Payments icon from your desktop or 

navigate to Start | Programs | Infor Global Solutions | TCPIP Manager | Launch TCPIP 
Manager. 

 
From this window you can: 

• Select Exit from the File menu to close the TCP/IP Manager – Electronic Payments. 
• Select Configure from the Tools menu to activate debugging or set the proxy server settings.  

Configuration of the TCP/IP Manager for Electronic Payments is necessary if you are using a 
proxy server.   

TCP/IP Manager for Electronic Payments 
Installation and Implementation Tips 

This section provides an overview of the TCP/IP Manager for Electronic Payments and all of the 
information that you need to install, start, and configure your application. 

If you are using a previous version of the TCP/IP Manager, to upgrade to the most current version you 
must uninstall the previous version and install the new version. 

NOTE:  The TCP/IP Manager - Electronic Payments is required only if you are using Payflow Pro 
with FACTS.  
c 
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Installing the TCP/IP Manager for Electronic Payments 

In this section, you will install the TCP/IP Manager - Electronic Payment on the same PC where you 
installed Payflow Pro. The installation program allows you to select the destination disk drive and 
directory for the installation and copies the TCP/IP files to the destination disk drive. 

Before you begin the installation: 

 Install Payflow Pro on a PC. 

 Disable any anti-virus software products. 

 Exit all Windows programs. 

 Disable all screen savers. 

To install the application: 

1. Insert the TCP/IP Manager installation CD-ROM into the CD-ROM drive of the PC where you 
installed Payflow Pro. After a few seconds, the setup application will run automatically. If your 
system does not support AutoPlay on the CD-ROM drive, select the Run command from the Start 
menu, enter D:\setup.exe (where D is the letter of your CD-ROM drive) and click OK. A progress bar 
displays while the InstallShield Wizard is being prepared. 

  

Then, the Welcome Window appears. 
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2. Click Next. The Customer Information Window appears. 

 

3. Enter your user name and company. Click Next.The Choose Destination Location Window appears. 
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4. By default, the TCP/IP Manager will be installed in C:\Program Files\Infor Global Solutions\TCPIP Manager 
- Electronic Payments\. If you do not want the TCP/IP Manager to be installed in this directory, click the 
Browse button and select a new location. Click Next. The Start Copying Files Window appears. 

 

5. Review the installation settings. Click Back to make any changes. Click Next to continue. The Setup 
Status Window appears.  
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6. When the installation is complete, the Install Shield Wizard Complete Window appears. 

 

7. Click Finish. You have completed the installation of the TCP/IP Manager - Electronic Payments 
application. 
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Starting the TCP/IP Manager - Electronic Payments 

1. Double-click the Launch TCP/IP Manager - Electronic Payments icon.  
The TCP/IP Manager - Electronic Payments Window appears. 

 

You have connected to the TCP/IP Manager for Electronic Payments. Electronic Payment transactions 
from FACTS will be processed as long as the TCP/IP Manager is running. 
From this window you can 
• Select Exit from the File menu to close the TCP/IP Manager - Electronic Payments. 
• Select Configure from the Tools menu to activate debugging or set the proxy server settings. 

Configuration of the TCP/IP Manager for Electronic Payments is necessary if you are using a 
proxy server. If you are using a proxy server, refer to Setting the Proxy Server Settings. If you need 
to troubleshoot processing, refer to Using the Debugging Feature. 

• Select About from the Help menu to display information about your release level.  

Setting the Proxy Server Settings 

Configuration of the TCP/IP Manager for Electronic Payments is necessary if you are using a proxy 
server for your Internet connection. If you are not using a proxy server, leave these settings blank. 

1. Select Configure from the Tools menu. The TCP/IP Manager - Electronic Payments Settings Window 
appears. 
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2. Set the following: 

TCP/IP Manager - Electronic Payments Settings Window Fields and Buttons 

Field/Button Description 

Debug Select this check box if you want the TCP/IP Manager 
for Electronic Payments to run in debug mode. Refer to 
Using the Debugging Feature for more information. 

Proxy Address Enter the IP address of the proxy server. 

Proxy Port Enter the port number used to access the proxy server. 

Proxy Log On Enter the user ID for logging on to the proxy server. 

Proxy Password Enter the password for the user ID. 

 
 

 

3. Click OK to save your settings. 

Using the Debugging Feature 

You can activate the debugging feature to help you troubleshoot if you are having communication issues. 

To activate debugging: 
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4. Select Configure from the Tools menu. The TCP/IP Manager - Electronic Payments Settings Window 
appears. 

5. Select the Debug field and click OK. You are returned to the TCP/IP Manager - Electronic Payments 
Window. 

6. As transactions are processed, the processing information will display in the TCP/IP Manager - 
Electronic Payments Window. 
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